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1 INTRODUCTION 

 

This section provides start-up instructions for the Oracle Cloud Applications. 

 

1.1 Sign-On to Cloud Applications  

To log into the application:  

1. Open internet browser window. Any browser can be used to access Cloud Application. 

2. Enter the URL below: 

                              

No. URL Type URL Link 

1.  TEST  https://fa-etei-test-saasfaprod1.fa.ocs.oraclecloud.com/  

 

2.  PROD https://fa-etei-saasfaprod1.fa.ocs.oraclecloud.com/  

 

Table 1: Direct Login URL 
 

3. The Sign In page appears. Enter your User ID and Password.  

 

 

Figure 1: Oracle Cloud Sign-In Page 

 

4. Your user ID and Password are case sensitive. Passwords always appear as asterisks 
in the display as you enter them.  

5. Tab to or Click the  button to sign in.  

6. Personal Homepage dashboard screen appears with CLOUD privilege access. 

https://fa-etei-test-saasfaprod1.fa.ocs.oraclecloud.com/
https://fa-etei-saasfaprod1.fa.ocs.oraclecloud.com/
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1.2 Navigating from Personal Home Page to Applications 

After you log in to Oracle Applications, your Oracle Financial Cloud Home page is displayed. 
All the functionality within the Oracle Cloud applications revolves around homepage which you 
can personalize. From here you can: 

1. Get a quick glance at your work-related conversations and announcements. 

2. Use the Application Link icons to navigate the pages and dashboards to perform your 
day-to-day activities.  

3. Access the Navigator to access any additional applications that are not available in the 
application section on the home page. 

4. Favourite list of quick actions to quickly perform some key tasks. 

 

Note: 

The exact appearance of your windows may vary depending on your personalization and roles 
that is assign to you. 

 

 

Figure 2: Personal Home Page 

 

 

 

 

 

 

 

Figure 3: Navigation Tools in the Global Area of the Home Page 

Navigator 

Home 

Watchlist 

Settings
& Action 

Logo Favorites & 
recent item Notification 
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Once you have set your homepage as the Newsfeed Home Page, then it will come with 
different sections. 

Apps Section  

 

  

Figure 4: Apps Section 

 

Within the Apps section, you have various icons that can be used to start navigating into the 
different work areas of an application. For example, if you would like to navigate to the Assets 
work area within Fixed Assets, you will select your application as Fixed Assets and you will 
choose Assets in the Apps section. When you select Assets, the system takes you to the 
Assets work area, where you can perform various activities, such as asset creation, managing 
assets, generating accounting for your assets, etc. Once your work has been completed, you 
can go back to the home page by using the home icon. 

You can also access the apps via the Navigator.  

Here, the access is granted to various work areas based on the roles that have been given to 
your user account. You have the flexibility to personalize the App section. You can decide 
what you want to show within these springboard icons and what you want to hide. If you are 
an order regular visitor to the Fixed Assets work area, you mostly work with Assets, you can 
hide other apps. So, it will not be shown in the Apps icon but only accessible through the 
Navigator. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click this to 
personalize 
springboard 
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Things to Finish section  

 

 

Figure 5: Things to Finish Section 

 

The Things to Finish section provides you with a count of any pending notifications that are 
assigned to you and may require an action from you. Account Link named Created by Me list 
the approval requests that you have created. You can click the link to navigate to a full list of 
notifications pertaining to that account. Then the items listed in the Things to Finish section 
are same as the notifications that are listed in the global header.  

The same information is available when you click on notifications icon. You can access the 
same number of notifications from here, as well as from the Things to Finish section. The list 
displays the latest notification first and allows you to scroll horizontally to view more 
notifications.  

You can clear a notification from the list by clicking the Close icon. When you clear a 
notification, the count does not change, since no action is taken on that notification. If you click 
on numbers of Assigned to Me or Created by Me, you will get a listing of all the notifications 
that show the notifications that require an action from you. When you click on the any list of 
items, it opens the notification, and you can get the details of the notification. If you are 
satisfied, you can either approve it or you can either reject it. Once the notification is read then 
the count will change. 
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Analytics section  

 

 

Figure 6: Analytics Section 

 

As far as financials is concerned, there are currently 5 choices of analytics display and they 
are Cash Management Infolets, General Accounting Infolets, Service Infolets, Source to Settle 
Infolets, and Order to Cash Infolets. You can personalize the Analytics section and decide 
which Infolets should be visible, which should not be visible.  

 

1.3 Creating Favorites and Setting Preferences  

Creating Favorites 

Each user has their own favorites and adding favorites is easy in cloud. Just go to your favorite 
work area or task page. Click on the favorite icon and click Add to Favorites.  By this you get 
to your favorite pages directly and easily when you click the favorite icon. You can remove 
unwanted pages by clicking Manage Favorites. 

 

 

Figure 7: Creating and Managing Favorites 

 

Click on this icon to either 
hide or display a particular 
infolet. 

Infolets 
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Set Preferences 

Select Preferences to set personal options such as regional, language, accessibility setting, 
watchlist and etc as shown in the list of Figure 8. You can also reset your password from the 
Preferences page. To get into set preferences, click on setting and action dropdown menu 
click on Set Preferences. 

 

 

Figure 8: Set Preferences 

 

1.4 Overview of Using Work Areas to Streamline Business Processes 

Use work areas to gain instant insight into your business and identify potential problems with 
processing transactions.  

Work areas can include the following: 

• Infotiles 

• Content Area 

• Actions Toolbar 

• Tasks Panel Tab 

• Reports and Analytics Panel Tab 
 

 

 

 

 

Figure 9: Assets Work Area 

Infotiles 

Content Area 

Task Panel 

Report and 
Analytics Panel 

Actions Toolbar 
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Infotiles 

Summarize a high volume of transactional information. You can quickly identify potential 
problems and prioritize your daily activities by scanning the infotiles and accessing transaction 
details. 

For example, select an infotile to display corresponding transactional information in the content 
area. You can also click links in the infotile to filter the records in greater detail in the content 
area. 

 

Content Area 

The content area displays transactional information related to the infotile you select. You can 
review the detailed information and take the necessary action. 

For example, click the item link in the table to drill down to transaction-level information. You 
can perform multiple actions on the transaction, such as edit, submit or save the assets. 

 

Actions Toolbar 

Use the actions toolbar to perform a range of activities on one or more rows you select in the 
content area. 

For example, select a transaction row and use the View menu to view the transaction in more 
detail. You can export the data to an Excel worksheet, Detach the Pane, Prepare, Merge, Add 
to Asset, Split or Change Book. 

 

Tasks Panel Tab 

The Tasks panel includes tasks that are related to the work area and that you have access to 
perform. 

For example: Add, Adjust, Impair, Transfer, Retire, Reinstate, or Update Assets as well as 
Create Accounting or Adjustment Journal. You may also view all created assets by navigate 
to Inquire Assets. 

 

Reports and Analytics Panel Tab 

The Reports and Analytics panel tab contains predefined reports as well as a folder for you to 
set up your own reports. 

For example, use the predefined reports to perform a deeper analysis on Assets. You can also 
access reports that you have copied and modified and stored in your own folder. 
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1.5 Scheduled Processes 

Scheduled processes do tasks that are too complex or time-consuming to do manually, for 
example importing data or updating many records. You can run scheduled processes on a 
recurring schedule and send notifications based on how the process ends. Some scheduled 
processes give you printable output. Those processes might have Report in their name. 

 

Jobs  

Each scheduled process that you run is based on a job. The job is the executable that controls 
what the process can do and what parameters and other options you have for the process. A 
job set contains multiple jobs. 

Job definitions can be set on Oracle Business Intelligence Publisher reports so that people 
can run the reports as scheduled processes. 

 

Process Sets 

A process set is a scheduled process that is based on a job set. So, when you submit a 
process set, you are running more than one job. 

Note: When you submit certain scheduled processes, the job logic causes other processes to 
automatically run. But in this case, you are not submitting a process set that includes those 
other processes. 

 

Submission 

When you submit a scheduled process, you can use its parameters to control which records 
are processed and how. Some scheduled processes do not have parameters. 

As part of the submission, you can also set up a schedule for the process, for example to run 
once a week for two months. Every time a process runs, there is a unique process ID. 

 

Output 

Some scheduled processes provide output in PDF, HTML, and other formats. For example, a 
process can import records and produce output with details about those records. There are 
many types of output, for example a tax document or a list of transactions. 

 

Process Sets 

A process set is a type of scheduled process that is based on a job set and contains at least 
two processes. So, you can run many processes in one go, for a specific purpose. These 
processes run in a certain order, in serial or parallel, or by some other logic.  

Process sets can have any number of individual scheduled processes and even other process 
sets.  
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To Submit Scheduled Processes 

Click Navigator > Tools > Scheduled Processes. 
 
 

 

Figure 10: Scheduled Processes Overview Page 

 

1. On the Scheduled Processes Overview page, click Schedule New Process. 

2. Leave the type as Job, enter the process that you want to submit, and click OK. 

3. In the Process Details dialog box, enter at least the required parameters, if any.  

 
Some processes have no parameters at all. Some parameters depend on other 

parameters. For example, date range parameters might appear only after you select 

By Date for another parameter. 

 
4. Click the Advanced button if you want to define the schedule, notifications, or output.  

5. Continue to the next steps. You may skip Step 4 and Step 5.  

6. Click Submit, to run the process once as soon as possible with the default output. 

 

Define the Schedule 

Set up a schedule to run the process on a recurring basis or at a specific time. Use the Process 
Details dialog box in Advanced mode. 
 

1. Open the Schedule tab and select Using a schedule for the Run option. 

2. Select a frequency. 

3. Select User-Defined if you want to enter the exact dates and times to run the process. 

4. You can select Use a Saved Schedule to use an existing schedule if there are any. 

5. Depending on the frequency, define when the process should run. 
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Define the Output 

You can choose the layout, format, and destination for your output. Use the Process Details 
dialog box in Advanced mode. 
 

1. Open the Output tab, if available. 

2. Click Add Output Document. 

3. Change the name if you want. The name identifies this output document when you go 

to view output later. 

4. Select a layout if you have more than one to choose from. 

5. Select a format, for example one of these: 

 
 PDF : Is the best option if you want to print the output.  
 Excel : Supports embedded images, such as charts and logos, but can be 

opened only in Excel 2003 or higher. 
 

 Data : Gives you report data in an XML file, which is used mainly for editing the 
report layout. 

 

 
6. Click Add Destination to send the output somewhere, for example to a printer or email 

address. You can add many destinations and send the output to all of them at the same 

time. 

 
Tip: You can also print the output as part of the steps for finishing the submission, 

instead of adding a printer destination here. 

 

To add more output documents, repeat steps 2 to 6. 

 

Set Up Notifications 

You can have notifications sent out depending on how the process ends. Use the Process 
Details dialog box in Advanced mode to set that up. 
 

1. Open the Notification tab. 

2. Click Create Notification. 

3. In the Recipient field, enter the user ID of the person you want to send the notification 

to. 

4. In the Condition list, select when to send the notification, for example when the process 

ends in error. 

5. Click OK. 

 
To send notifications to more people, repeat steps 2 to 5. 
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Finish the Submission 

Follow these steps in the Process Details dialog box: 
 

1. Click the Process Options button if you want to define settings that affect the data to 

be processed. 

2. If the process gives you output and you want to print it, select the Print output check 

box and a printer. 

3. Select the Notify me when this process ends check box if you want to get an email 

notification. 

4. Enter submission notes to capture any information that you want to associate with this 

submission. You can use your notes to find this submission later. 

5. Click Submit. 

6. Click OK to confirm. 

 
Tip: Note down the process ID for your submission so you can easily find it later. For example, 
you set the process to run once a week. Later, if you want to cancel all runs on this schedule, 
you need to cancel this original submission with this process ID. 
 
 

To Submit Process Sets 

To submit a process set from the Scheduled Processes Overview page: 
 

1. Proceed with the steps that you would follow to submit any scheduled process, but 

select Job Set for the Type option. 

2. In the Process details dialog box, set parameters for individual processes in the set. A 

process set itself does not have parameters. 

a. Select a process on the Processes tab. 

b. Enter parameters for that process, if any. 

c. Repeat for other processes in the set. 

3. Define the schedule, output, and notifications for the process set, as you would do for 

any scheduled process. 

4. Set any other options and click Submit. 
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To Check Status 

1. Click Navigator > Tools > Scheduled Processes. 
The Search Results table shows processes that match the default saved search, Last 
24 hours. 

• The table might be blank if nothing was submitted. 

• If submission notes were entered when submitting the process, you can use the 
Submission Notes column to help identify the process. 

2. If you don't see the process, click the Refresh icon or use the Search section. 
3. Do any of these tasks to check on the progress of the process: 

• For more details about the status, click the status link. For example, if a process is 
in the Ready status, you can click the Ready link in the Status column to see where 
the process is in the submission queue. 

• Check the Start Time column to see if the process has started running yet. 

• In the Search Results table, find the This Job's Items Processed / Errors / Total 
column. For some scheduled processes, this column shows what's getting 
processed and how things are going.  

• Click the View Log button, especially if your process has a blank This Job's Items 
Processed / Errors / Total column. The type of information in the log varies, 
depending on the process. You can open the log from here only if the process is 
currently running. When the process is done, you might want to also take a look at 
the final log, if any, from the Details section. 

 

To View Output from Scheduled Processes 

1. Click Navigator > Tools > Scheduled Process. 
2. Find your scheduled process and, if you need to, refresh the search results to see the 

latest status. 
3. Select the scheduled process. 
4. Go to the Output subsection in the Details section. 
5. Click the link in the Output Name column to view or download the output, which you 

can then print. 
6. To view or export the output in a different format: 

a. Click the Republish button. 
b. Click the Actions icon. 
c. Select Export, and then select a format. 
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2 ASSETS INFOTILES 

 

The new Assets page provides a quick overview of your key fixed asset transactions like 
additions, transfers, adjustments, and retirements, allowing you to focus right away on what 
needs your attention. All of your transaction data is conveniently summarized into infotiles, 
providing you the option to drill into more details for further analysis and quick actions. The 
infotiles for Assets push critical information to enable you to take action to resolve exceptions 
and complete processing of asset data to ensure accuracy prior to period close. 

 
1. Access the Assets Page by clicking on the Fixed Assets icon on the springboard, then 

selecting the Assets icon. 
 

 

Figure 11: Personal Home Page 

 

2. The Assets page allows you to focus on a single asset book at a time. You can use 
the list of values to filter and review data for any specific Fixed Assets Book. 

 

 

Figure 12: Select Book Navigation 
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2.1 Additions Infotile 

 

You can quickly scan the asset additions information coming from payables invoices using the 
Additions Infotile. Apart from the data coming from other subledgers, this infotile will also 
contain manually added assets. 

 

Use the Incomplete Count to review summary 
information of all incomplete addition lines requiring your 
attention. This information includes the count of 
incomplete additions with missing asset category, 
depreciation expense account and/or location, or even 
lines that are not yet set to the Post status. You can click 
the warning icon on the left of the addition line to see the 
recommended action. 

 

Use the Exceptions count for timely review of addition 
lines with warnings or errors. This will allow you to resolve 
the exceptions in a timely manner. 

 

 

Use the Ready to Post count to view the addition lines that are pending posting. Once 
posted, these lines will be created as assets. 

 

The corresponding detail table lets you view and prepare addition lines, correct errors and 
exceptions.  

 

You can merge the addition lines to create an asset or split one addition line to create multiple 
assets.  

 

You can add an addition line to an existing asset using the Add to Asset action. 

 

Prepare All launches a spreadsheet which allows you to quickly fill out the required 
information, and even post these lines to create assets. You can also deal with any posting 
exceptions or errors on this page. 

 

 

Figure 13: Additions Infotile 

 

By default, and based on context, some columns are hidden. Use the View menu to show, 
hide or reorder columns. 



Olivestouch Technologies Sdn Bhd 
                                                                              User Manual 

 Fixed Assets Module 

 

Confidential  Page 24 of 129 

 

2.2 Adjustments Infotile 

 

Use the Adjustments Infotile to view and prepare the incomplete mass adjustment 
transactions including, but not limited to, cost adjustments, book adjustments, 
reclassifications, revaluations, impairments, suspension and continuation of depreciation, etc.  

 

You can complete the adjustment transactions from 
the corresponding detail table. You can complete your 
adjustment transactions in the spreadsheet by 
clicking on the Prepare button or, you can adjust each 
asset individually by clicking on the Transaction Type 
hyperlink. You can view the former details by clicking 

on the icon. 

 

 

 

Figure 14: Adjustments Infotile 
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2.3 Transfers Infotile 

 

You can use the Transfers Infotile to view the incomplete mass transfers. You can use the 
corresponding detail table to prepare the transfer transactions for finalization. 

 

You can complete the transfer of transactions 
from its corresponding detail table. You can 
complete the transfer of transactions in the 
spreadsheet by clicking on the Prepare button 
or, you can transfer each asset individually by 
clicking on the Transfer hyperlink. You can view 

the old assignments by clicking on the icon. 
Clicking on the blue dot will give you specific 
information about the old depreciation expense 
account.  

 

 

Figure 15: Transfers Infotile 
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2.4 Retirements Infotile 

 

Use the Retirements Infotile to review all of your pending retirement transactions. 

 

Use the Incomplete count to 
review summary information of all 
of your incomplete retirement 
transactions including your mass 
retirements. Use the Exceptions 
count to view all retirements with 
warnings or errors for a quick and 
timely resolution. Use the Ready 
to Post count to view the 
retirements that are pending 
posting.  

 

Use the corresponding detail table to view all the information regarding the retirement cost, 
proceeds, and other details. You can prepare the lines online or in the spreadsheet and finally 
post them to finalize your retirement transaction. 

 

 

Figure 16: Retirements Infotile 

 

2.5 Depreciation Infotile 

 

You can use the Depreciation Infotile to calculate depreciation and close your period for the 
Fixed Asset Subledger. You can also view the counts of completed additions and retirements, 
and even drill down to view the details of the completed additions and retirements from this 
page. 

 

 

Figure 17: Depreciation Infotile 
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3 FIXED ASSET WORKBENCH AREA 

 
Once logged in, you will land on the home page. Access the Fixed Assets work area by clicking 
the Fixed Assets icon on the springboard, then select Assets. 
 

 
 

Figure 18: Personal Home Page 
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3.1 Create Mass Additions 

 

Prerequisites 

✓ User must have Account Payables roles. 
✓ Invoice should be Validated & Accounted. For manual invoice creation, the designated 

Asset Clearing A/C of the Asset Category should be used as the distribution Code at the 
Invoice. 

✓ Track as Asset Checkbox should be enabled 
 

Process Flow: 

1. Go to Payables > Invoice. 

 

 

Figure 19: Personal Home Page 

 
2. Click on Create Mass Addition task from the Task panel for transferring Qualified 

Asset Invoices to Fixed Asset Module from the Payables module. 

 

 

Figure 20: Tasks Sidebar in Invoices Work Area 
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3. Enter information for Invoice Accounting Date and Book Name. Then click on Submit 

button. 

 

 

Figure 21: Submit Request Page 

 
4. Then review the program and report in the scheduled processes.  

Go to Homepage, click on Navigator Icon at the top left. 

 

 

Figure 22: Personal Home Page 

 
5. Go to Tools > Schedule Process. 

 

 

Figure 23: Navigator 
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6. Choose the Create Mass Additions Report. 
 

 

Figure 24: Scheduled Processes Page 

 

7. Click the Output Name. 
 

 

Figure 25: Create Mass Additions Report Log & Output 

 
8. Here the same sample report. 

 

 

Figure 26: Create Mass Additions Report 
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3.2 Asset Creation from Mass Additions 

 

Prerequisites 

✓ Assets Books and Categories are defined. 
✓ User has a role to access the relevant Asset Books. 
✓ Create Mass Additions Process is run to transfer Asset Invoices to the Fixed Assets 

Module 
 

Process Summary 

Manually add assets to the Fixed Assets Register by entering all required information and any 
optional information directly using: 
 
✓ Add Asset Screen (generally used to enter a single asset) 
✓ Spreadsheet (generally used to enter multiple assets) 

 

3.2.1 Post Mass Additions by Screen 

 

This process can be followed when an asset needs to be added from an Asset Invoice that 
has been transferred to the Fixed Assets Module for Asset Creation. For a single asset 
creation, the following steps can be followed in the Add Asset Form. 

 
1. In the Asset Addition Infotile, under the Incomplete section, you will be able to see the 

Asset Invoices that have been transferred into the Asset Module from the Payables 
Module (after running the Create Mass Additions process). 

 

 

Figure 27: List of Incomplete in Assets Work Area 
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2. Select the Line of the Payables Invoice that you wish to add as Asset. Click on Actions 
button and select Edit. 

 

 

Figure 28: Actions Dropdown List in Assets Work Area 

 
3. System will navigate into the below mentioned page. 

 

 

Figure 29: Edit Source Line Page 

 
4. Select an appropriate Asset Category. 

- Choose the major category, 
- Then click search to view all the available combinations 

 

 

Figure 30: Category Box 
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Figure 31: Major Category Search in Category Box 

 

 

Figure 32: List of Major and Minor Category in Category Box 

 
5. Enter the necessary details like: 

a. In-Service Date (Should be in open period) 
b. Description 
c. Category 
d. Tag Number 
e. Serial Number 
f. Company Asset Number 
g. Asset Key 

 

 

Figure 33: Descriptive Details Section 
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6. Enter Asset Key field as OTHER to avoid any Error upon submission. 
 

7. In the Assignments section, mention necessary details like Number of Units, 
Depreciation Expense Account and Location. 

 

 

Figure 34: Assignments Section 

 

Note that Oracle Fusion only auto generates the Depreciation Expense Account as default 
value based on Asset Categories Setup or you may manually change it accordingly. 

 

8. Next, please choose the Location. 

 

Figure 35: Location Box 
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9. Expand the Financial Details section and review the necessary details defaulted from 
the Asset Category selected: 
 

 

Figure 36: General Tab in Financial Details Section 

 

Review Details like: 
a. Depreciation Method 
b. Life of Asset 

Note: Life of an Asset is defaulted from Asset Categories Setup. However, you 
need to review life of an asset once before posting an asset. 

c. Depreciation Checkbox (whether to calculate depreciation on this asset or not) 
d. Prorate Convention 
e. Prorate Date (date start depreciation) 

 

 

 

 

 

 

 

 

 

 

 

 REMINDER 

As per agreed in the Implementation Session, for any Prorate Convention field, you need to 
select ‘LSE_HALFMO’. Setup Prorate stated as below: 

a. Purchase from 1st to 15th, depreciation start will become “Current Month” 

b. Purchase from 16th to end month, depreciation start will become “Following Month” 
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10. Next you can go to Source Information tab, here you can review the invoice that 

purchased asset. 

 

 

Figure 37: Source Information Tab in Financial Details Section 

 

11. After reviewing the necessary details, change the Queue Status of this record to Post 
and click on Save and Close. 
 

 

Figure 38: Edit Source Line Page 
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12. The Asset Addition Record will be moved to the Ready to Post section of Additions 
Infotile. Click on Post All and the asset will be created in your Fixed Assets Register. 

 

 

Figure 39: List of Ready to Post in Assets Work Area 

 

13. Next you may review the program status at schedule process. From the report, you 

can view the asset number generated by the system. 

 

 

Figure 40: Post Mass Additions Report Log & Output 

 

 

Figure 41: Post Mass Additions Report 

 

Once the process of Post Assets succeeds, you can view this asset in the Inquire Assets 
Dashboard. 
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3.2.2 Post Mass Additions by Spreadsheet 

 

This process can be used when multiple asset units need to be added from an Asset 
Invoice (or from multiple asset invoices) that has/have been transferred to the Fixed Assets 
Module for Asset Creation. For multiple asset creation in one go, the following steps can be 
followed in the FA Module and Spreadsheet. 

 

Oracle will credit Asset Clearing account (for Manual Payables Invoice Creation) at the time 
of adding the asset using Spreadsheet function of Fixed Asset addition.  

 
1. Click on Prepare All button to prepare these assets in a Spreadsheet. 

 

 

Figure 42: Prepare All Navigation in Assets Work Area 
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2. It will download a spreadsheet for Mass Addition. Connect to Oracle ERP and sign in 
with your user account. 
 

 

Figure 43: Excel Template Download 

 

 

Figure 44: Connect Prompt Box 

 

 

Figure 45: Login Page 
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3. It will retrieve a spreadsheet with details of all Asset Invoices that have come into the 
FA Module for Addition. 
Enter the details as per below manually 
- Queue Name = Post 
- Major, Minor and Group Category 
You can double click to have the List of Value (LOV). 
 
 

 

Figure 46: Queue Name and Category Columns 

 
- Asset Location 

- Depreciation Expense Account 

- Asset Key 

 

 

 

 

Figure 47: Locations, Depreciation Expense, Asset Key Columns 

 

 

4. For useful life, and depreciation method will follow the Asset Categories Setup. 
However, you may change if required. 
- Depreciation Method 
- Life in Years 
- Life in Months 

 

 

Figure 48: Depreciation Method, Life in Years, Life in Months Columns 
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5. Enter Salvage Value, this will impact the Net Book Value at the end of useful life period. 
- Salvage Type = Amount 

- Salvage Value Amount = 1 

 

 

Figure 49: Salvage Type and Salvage Value Amount Focused Columns 

 
6. You able to check other information related to Invoice and Purchase Order through: 

- Invoice Number 
- PO Number 
- Supplier Number 
- Supplier Name 
- Invoice Date 
- Invoice Line Description 

 
7. After that, Click on Post. 

- You can choose the post option 
- Then, click OK button to proceed 

 
 

 

Figure 50: Upload Options Prompt Box 

 
Oracle will run a program for Post Mass Additions. 
 

 

Figure 51: Confirmation Prompt Box 
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8. Then you may review the program status in the schedule process. 

 

Figure 52: Post Mass Additions Report Log & Output  

 

9. Here is the sample report. 

 

Figure 53: Post Mass Additions Report 
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3.2.3 Asset Split using Split Function 

For purchasing assets from Payables that contained more than 1 unit, and required to split as 
single unit, you may use Split Function. This function will split the assets equally into 1 for 
each line. 

 
1. Select the asset line, go to Action > Edit. 

 

 

Figure 54: List of Incomplete in Assets Work Area 

 

2. Click the Split button. 

 

Figure 55: Split Asset Navigation in Asset Work Area 

 
3. There will be warning message to confirm the split. Click Yes button to proceed. 

 

 

Figure 56: Warning Box 

 
4. The split has been successful. 

 

 

Figure 57: Confirmation Box 
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5. Then you may proceed to enter the relevant information and post the asset. 
 

 

Figure 58: List of Incomplete in Assets Work Area 

 

3.2.4 Increase Existing Asset using Add to Asset Function 

This function allows any user to Add the Cost into existing assets. 

 

1. Choose the asset lines and click Add to Asset button. 
 

 

Figure 59: Add to Asset Navigation in Assets Work Area 
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2. Then search for the existing asset that requires additional cost. 
 

3. Next, click Preview Add to Asset button. 
 

 

Figure 60: Add to Asset Page 

 

4. Review the result. 
 

5. Then click Add to Asset button to proceed. 
 

 

Figure 61: Preview Add to Asset Box 

 
6. The asset line will be ready to post. Go to Ready to Post and click Post All. 

 

Figure 62: List of Ready to Post and Post All Navigation in Assets Work Area 
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3.2.5 Combine Multiple Lines using Merge Function 

This function allows any user to merge the assets line into 1 asset. 

 
1. Click the asset lines that require to merge. 

 
2. Then click the Merge button. 

 

 

Figure 63: Merge Navigation in Assets Work Area 

 
3. It will show the preview result from the merge. 

You can change the description and tick the sum merged unit if you want to have 2 
unit for the asset. 
 

4. Click the Preview button. 
 

 

Figure 64: Lines Selected for Merge Box 

 
5. It will show the final result. Then click the Submit button to proceed. 

 

 

Figure 65: Preview Merge Box 
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6. After that, you may proceed to enter all the relevant information and post the asset. 
 

 

Figure 66: List of Incomplete in Assets Work Area 

 

3.2.6 Undo Process for Split, Merge and Add to Asset Function 

1. Go to Task > Prepare Source Lines. 

 

Figure 67: Task Sidebar in Assets Work Area 

 

2. Undo Split. 
Search Queue = Split 

 

Figure 68: Prepare Source Line Page 
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3. Choose the asset line, then go to Action > Undo Split. 
 

 

Figure 69: Undo Split Navigation 

 
4. Undo Merge. 

Search Queue = Merged 
 

 

Figure 70: Search Section in Prepare Source Line Page 

 
5. Choose the asset line. 

Then go to Action > Undo Merge. 
 

 

Figure 71: Undo Merge Navigation 
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6. Undo Add to Asset. 
Search Queue = Cost Adjustment 
 

 

Figure 72: Prepare Source Lines Page 

 
7. Choose the asset line. 

Then go to Action > Undo Add to Asset 

 

Figure 73: Undo Add to Asset Navigation 
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3.3 Manual Asset Creation 

 

Manual addition process to directly enter ordinary assets without interfering with other modules 
such as Procurement and Payables. 

 

Prerequisites 

✓ Assets Books and Categories are defined. 
✓ User has a role to access the relevant Asset Books. 

 

Process Summary 

Manually add assets to the Fixed Assets Register by entering all required information and any 
optional information directly using: 
 
✓ Add Asset Screen (generally used to enter a single asset) 
✓ Spreadsheet (generally used to enter multiple assets) 

 

3.3.1 Create Asset by Screen 

 

This process can be followed where there is no AP Invoice for an asset or adding existing 
assets which could not be identified during migrating assets from existing system to Oracle. 

 

Assets will be created manually in Fixed Asset module. Accounting entry will be as follows: 

 

No Scenario Module No. Accounting Entry Comments 

1. 
Manual 
Asset 
Addition 

Fixed 
Assets 

1. 

DR Asset Cost Account  Asset Cost and Asset 
Clearing Account is 
fetched from the Asset 
Category setup CR Asset Clearing Account 

Table 2: Accounting Entry of Manual Asset Addition 

 

1. Navigate to Fixed Assets > Assets > Task > Add Assets. 
 

 

Figure 74: Task Sidebar in Assets Work Area 
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2. Enter information in the fields like Book name, Assets type as Capitalized/Expensed, 
Category, Description, Cost, Unit, Location assignment. Expense Account will auto 
generate based on Asset Categories Setup, 
 

 

Figure 75: Add Asset Box 

 
3. Enter the information in mandatory fields and optional fields on the basis of requirement like 

Header, Descriptive Details, Assignment and Financial Details. 
 

 

Figure 76: Add Asset Page 
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4. Expand the Financial Details. Enter financial details which consist of General 
Information Salvage Value (if any). 
 
The Depreciation Method, and Life of Asset will auto populate based on the asset 
category. However, you may change if required. 

 

 

Figure 77: General Tab in Financial Details Section 

 
5. Click on Submit button to proceed. 

 

 

Figure 78: Submit Navigation in Add Asset Page 

 

6. Asset will be moved to the Ready to Post section of Additions Infotile. Click on Post 

All and the asset will be created in your Fixed Assets Register. 

 

 

Figure 79: List of Ready to Post in Assets Work Area 
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3.3.2 Create Asset by Spreadsheet 

 

This process can be used when multiple asset units need to be added manually. 

 

This process could also be used for migrating assets from existing system to Oracle. All 
existing assets will be loaded using spreadsheet along with details of this year’s Depreciation 
details (YTD Depreciation), Accumulated Depreciation till date (Depreciation Reserve) etc.  

 
1. Navigate to Fixed Assets > Assets > Task > Add Assets in Spreadsheet. 

 

 

Figure 80: Task Sidebar in Assets Work Area 

 
2. It will download a spreadsheet for Mass Addition. Connect to Oracle ERP and sign in 

with your user account. 
 

 

Figure 81: Excel Template Download 

 

 

Figure 82: Connect Prompt Box 
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Figure 83: Login Page 

 
3. It will retrieve a spreadsheet with details of all Asset Invoices that have come into the 

FA Module for Addition. 
Enter the details as per below manually 
- Interface Line Number = Ascending Numbering (1,2,3,…) 
- Asset Type = Capitalized or Expensed 
- Queue Name = Post 
- Description 
- Major, Minor and Group Category 
You can double click to have the List of Value (LOV) 
 

 

Figure 84: Excel Focused Columns 

 
- Date Placed in Service 

- Cost 

- Units 

- Asset Location 

- Depreciation Expense Account 

- Asset Key 

 

 

Figure 85: Excel Focused Columns 
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4. For useful life, and depreciation method will follow the Asset Categories Setup. 
However, you may change if required. 
- Depreciation Method 
- Life in Years 
- Life in Months 

 

 

Figure 86: Depreciation Method, Life in Years, Life in Months Columns 

 
5. Enter Salvage Value, this will impact the Net Book Value at the end of useful life period. 

- Salvage Type = Amount 

- Salvage Value Amount = 1 

 

 

Figure 87: Salvage Type and Salvage Value Amount Columns 

 
6. After that, Click on Post. 

- You can choose the post option 
- Then, click OK button to proceed 

 

 

Figure 88: Upload Options Prompt Box 

 
Oracle will run a program for Post Mass Additions. 
 

 

Figure 89: Confirmation Prompt Box 
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7. Asset will be moved to the Ready to Post section of Additions Infotile. Click on Post 

All and the asset will be created in your Fixed Assets Register. 

 

 

Figure 90: List of Ready to Post in Assets Work Area 
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4 ASSETS ADJUSTMENT 

 

Asset adjustment includes: 

1. Financial Impact: Influences monetary information through journal creation including 

changes in cost, depreciation amount, useful life  

2. Non-Financial Impact: Changes of descriptive information like asset number, serial 

number, model name. 

 

4.1 Change Financial Details 

 
Process Summary 

✓ Changes in financial information like cost, useful life, date in service and etc. 

 
1. Click on the Assets menu under Fixed Assets. 

 

 

Figure 91: Personal Home Page 

 
2. Click on Adjust Asset task from the Task list. 

 

 

Figure 92: Tasks Sidebar in Assets Work Area 

 
 
 
 
 
 
 



Olivestouch Technologies Sdn Bhd 
                                                                              User Manual 

 Fixed Assets Module 

 

Confidential  Page 58 of 129 

 

3. Select the Book and enter the relevant search criteria. Then click on Search button. 
 

 

Figure 93: Adjust Assets Page 

 
4. Select the Asset, click on the Change Financial Details button. 

 

 

Figure 94: Change Financial Details Navigation in Adjust Assets Page 

 

5. Once the system navigates into the Change Financial Details page.  
There are Amortize checkbox: 
- You need to check Amortize check box if adjustment needs to be spread over the 

remaining useful life of the assets 
- Else, system will auto recalculate the adjustment from the date starts depreciate 

 

 

Figure 95: Change Financial Details Page 
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6. Go to Financial Details then General section. 
From here you can change the financial data for the asset. 
 

 

Figure 96: General Tab in Financial Details Section 

 
Note: if you are changing the asset cost, there will be accounting entries generated. 
 

No.  Dr Cr 

1.  Increase cost Asset Cost Account Asset Clearing Account 

2.  Decrease cost Asset Clearing Account Asset Cost Account 

Table 3: Asset Cost Journal Entries 

 

7. After all the data is entered, click on Submit button to complete the adjustment. 
 

 

Figure 97: Submit Navigation in Change Financial Details Page 
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4.2 Transfer Source Lines 
 

Process Summary 

✓ Transfer cost between assets. 

 

1. Click on the Assets menu under Fixed Assets. 
 

 

Figure 98: Personal Home Page 

 
2. Click on Adjust Asset task from the Task list. 

 

 

Figure 99: Task Sidebar in Assets Work Area 

 
3. Select the Book and enter the relevant search criteria. Then click on Search button. 

 

 

Figure 100: Adjust Assets Page 
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4. Select the asset. 
Click on Transfer Source Lines button. 
 

 

Figure 101: Transfer Source Line in Adjust Assets Page 

 
5. Enter the Transfer Amount from the asset. 

The system will show the new asset cost after transfer. 
 

 

Figure 102: Transfer Source Lines Page 

 
6. Then, search for the Destination Assets that are being transferred to. 

Click on Search button. 
 

 

Figure 103: Search: Destination Assets Section 
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7. Choose the desired asset. 
 

 

Figure 104: List of Asset Number in Search: Destination Assets Section 

 
8. Finally, click on Transfer button at the top right to complete the transaction. 

 

 

Figure 105: Transfer Navigation in Transfer Source Lines Page
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4.3 Change Category 

 

Process Summary 

✓ Reclassification of an asset is simply changing the category of an asset. 

 
1. Click on the Assets menu under Fixed Assets. 

 

 

Figure 106: Personal Home Page 

 
2. Click on Adjust Asset task from the Task list. 

 

 

Figure 107: Task Sidebar in Assets Work Area 

 
3. Select the Book and enter the relevant search criteria. 

Then click on Search button. 
 

 

Figure 108: Adjust Assets Page 
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4. Select Asset which you want to reclassify. 
Click on Change Category button. 
 

 

Figure 109: Change Category Navigation in Adjust Assets Page 

 
5. Enter New category in which you want to reclassify Asset. 

Then click on Submit button to complete. 
 

 

 
 

 
 

 

Figure 110: Change Category Page 
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4.4 Update Descriptive Details 

 

Process Summary 

✓ Changes in non-financial information like Asset Number, Description, Tag Number etc. 

 

1. Click on the Asset menu under Fixed Assets. 
 

 

Figure 111: Personal Home Page 

 
2. Click on Update Descriptive Details task from the Task list. 

 

 

Figure 112: Task Sidebar in Assets Work Area 
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3. Select the Book and enter the relevant search criteria. 

Then click on Search Button. 

 

 

Figure 113: Update Descriptive Details Page 

 

4. Select the Asset, click on the Change Descriptive Details button. 

 

 

Figure 114: Change Descriptive Details Navigation 
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5. Once the system navigates into Change Descriptive Details page. 

From here you can change the non-financial data for the assets. 

 

 

Figure 115: Descriptive Details Section 

 

6. After all the data is entered, click on Save and Close button to complete the 

adjustment. 

 

 

Figure 116: Save and Close Navigation 
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5 ASSETS TRANSFER 

 

Transfer of fixed assets including transferring between locations and units. 

 

Prerequisites  

✓ Change the transfer date to a date in a prior period for a particular transfer, but the transfer 

must occur within the current fiscal year  

✓ Amend the transfer date of an asset to a prior period only once per asset.  

✓ Cannot transfer an asset to a future period. 

 

5.1 Transfer Asset 

 

Process Summary 

✓ This function shows you how to transfer asset from one location to another location. 

 
1. Click on the Assets menu under Fixed Assets. 

 

 

Figure 117: Personal Home Page 

 
2. Click on Transfer Asset under Task. 

 

 

Figure 118: Tasks Sidebar in Assets Work Area 
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3. Select the Book and enter the relevant search criteria.  
Then click on Search button. 

 

 

Figure 119: Transfer Assets Page 

 
4. Select the Asset, then, you will see the Assignment section, it shows the existing 

information of the asset. 
 

5. Click on the Transfer Asset button to proceed. 
 

 

Figure 120: Adjust Units Navigation in Transfer Assets Page 

 

6. Click  button and system will add a new line with empty field. 
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7. Insert: 
- New Units = Number 
- Depreciation Expense Account = Same account 
- Location = New location 

 

 
 

8. Change units of previous line accordingly. 
 

9. Then, Click on Submit button to complete the transaction. 
 

 

Figure 121: Adjust Units Page 
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5.2 Adjust Unit 

 

Process Summary 

✓ This function shows you how to adjust unit of the asset. 

 
1. Click on the Assets menu under Fixed Assets. 

 

 

Figure 122: Personal Home Page 

 
2. Click on Transfer Asset under Task. 

 

 

Figure 123: Tasks Sidebar in Assets Work Area 

 
3. Select the Book and enter the relevant search criteria.  

Then click on Search button. 
 

 

Figure 124: Transfer Assets Page 
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4. Select the Asset, then, you will see the Assignment section, it shows the existing 
information of the asset. 
 

5. Click on the Adjust Units button to proceed. 
 

 

Figure 125: Adjust Units Navigation in Transfer Assets Page 

 

6. Enter the New Units of the asset. 
Then, Click on Submit button to complete the transaction. 
 

 

Figure 126: Adjust Units Page 
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6 ASSETS RETIREMENT AND REINSTATEMENT 

 

Process Summary 

You retire an asset fully or partially when it is lost, stolen, damaged, sold, returned, or for any 
other reason that causes you to stop using it: 
a. Retire assets by cost or units. 
b. Reinstate retired assets within certain limits. 
c. Perform current and prior period retirements and reinstatements within the same fiscal 

year.  

 

6.1 Asset Retirement and Disposal Process Flow 

Oracle Fixed Assets module will automatically calculate gain/loss on asset retirement or 
disposal once you perform retirement process. Accounting entries will be as follows: 

 

No Scenario Module Accounting Entry Comments 

1. 
Asset 
Retirement 

Fixed Assets 
Module 

DR Fixed Asset Disposal - 
Clearing 
(*Proceeds of Sale Clearing) 

Asset Retirement 
Entry 

DR Accumulated Depreciation 

DR Cost of Removal 

DR NBV Retired 

CR Proceeds of Sale 

CR Cost 

CR Fixed Asset Disposal - 
Clearing 
(*Cost of Removal Clearing) 

Table 4: Asset Retirement Entry 

 

For retirement with sale, the system will generate the 'Proceeds of Sale Clearing' and 'Cost of 
Removal Clearing' accordingly based on the net book value and the sale of the asset. You 
may perform manual journal entry to offset this clearing account upon cash receipt: 

 

No Scenario Module Accounting Entry Comments 

1. 
Asset 
Retirement 

Fixed Assets 
Module 

DR Cash 
Apply Cash Receipt 
to offset clearing 
account 

CR Fixed Asset Disposal - 
Clearing Acc 

Table 5: Cash Receipt Entry 
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6.1.1 Retire by Cost 

 
1. Click on Assets under Fixed Assets springboard. 
 

 

Figure 127: Personal Home Page 

 
2. Click on Task > Retire Assets. 

 

 

Figure 128: Task Sidebar in Assets Work Area 

 

3. Enter the Book name and other details then click on the Search button. 
 

 

Figure 129: Retire Assets Page 
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4. Select the Assets which you want to retire then click on Retire Cost button. 
 

 

Figure 130: Retire Cost Navigation in Retire Assets Page 

 

5. Enter the Required information like Cost of Assets you want to Retire, Proceed of 
Sales, Cost of Removal if any. Select the Retirement Reason on the List of Values. 
 

6. Click on the Submit button to complete the retirement. 
 

 

Figure 131: Retire Cost Page 
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6.1.2 Retire by Units 

 
1. In this Case, after selecting the Asset which you want to retire, click on the Retire 

Units button. 
 

 

Figure 132: Retire Units Navigation in Retire Assets Page 

 

2. On the Retire Units page, you need to write the unit in the Retired Units Column for 
units which you want to retire. 

 

 

Figure 133: Retire Units Page 

 
3. As soon as we enter the Units to be retired, the system automatically calculates the 

cost to be retired. 
Thereafter, enter information like comments as for the reason of retirement, sale 
proceeds, cost of removal etc. 
 

 

 

Figure 134: Retirement Details Section 
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4. Then, click on the Submit button at the top right of the screen to complete. 
 

 

Figure 135: Submit Navigation in Retire Units Page 
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6.2 Asset Reinstatement 

 

Prerequisites 

You may reinstate any asset which is still in use but accidentally retired. 
 

Process Summary 

Reinstatements are reversals of retirements, which correct retirement errors by undoing the 
retirement of an asset and reinstating it.  
 

1. Click on assets under Fixed Assets springboard. 
 

 

Figure 136: Personal Home Page 

 
2. Click on Task > Reinstate Assets. 

 

Figure 137: Task Sidebar in Assets Work Area 
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3. Query the Asset you wish to reinstate. 
 

 

Figure 138: Reinstate Assets Page 

 

4. Select that Asset line from the search results and click on Reinstate button. 

 

Figure 139: Reinstate Navigation in Reinstate Assets Page 

 

5. A warning message will be shown by the system but just click on Yes to proceed. 

 

Figure 140: Warning Box 

 

Note on Reinstatement: Even after retiring the asset several months ago, Reinstatement 
have the effect of computing depreciation for the missed months as a result of asset 
retirement. 

As an example, let’s say assets have been retired in the month of February and reinstated on 
the Month of April. Reinstatement effect will be from the month of February, which is the 
retirement date.  
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7 ASSETS INQUIRY 

7.1 Asset Inquiry Overview 

 
The Asset Inquiry function allows users to quickly search, view, and analyze detailed 
information about fixed assets. It provides real-time visibility into asset transactions, 
depreciation, and assignments, enabling efficient asset management and decision-making. 
 

1. Click on Asset Inquiry under Fixed assets springboard. 
 

 

Figure 141: Personal Home Page 

 
Or at the Asset Page, go to Task > Inquire Assets. 

 

 

Figure 142: Task Sidebar in Assets Area Work 
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2. Search the assets by available fields below. 
 

 

Figure 143: Assets Tab in Asset Inquiry Page 

 
3. Enter the search parameter to inquire the asset. 

Additional fields in searching for an asset can be done by selecting the Advanced tab. 
 

 

Figure 144: Advanced Navigation in Search Section 

 
4. Then you can Add Field for searching criteria. 

 

 

Figure 145: Add Fields Navigation in Search Section 
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5. You are also able to save the search criteria for future use. 
 

6. Click the Save button and enter the name. 
 

 

Figure 146: Create Save Search Navigation 

 
7. Then it will appear in the Saved Search List of Values (LOV). 

 

 

Figure 147: List of Save Search 
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8. System also provide inquiry based on transaction made, recent addition and recent 
retirement for the period. 

 

 

Figure 148: Transactions Tab in Asset Inquiry Page 

 

 

Figure 149: Recent Additions Tab in Asset Inquiry Page 

 

 

Figure 150: Recent Retirement Tab in Asset Inquiry Page 
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7.2 Asset Inquiry Details 

 

Next, we go to the information that can be gathered from the asset inquiry page. 

 

1. Search for the asset. 
 

 

Figure 151: Search Section 

 
2. At the top header, it will show the Main information of the assets. 

 
3. Then, at the Books section, system show which FA Book for the asset, and the other 

information such as Asset Type, Category, Cost and Net Book Value. 
 

 

Figure 152: List of Search Section 
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4. Next, under Books Detail section, there are several tabs: 
a. The Financial tab will show the financial information of the asset. 

 

 

Figure 153: Financial Tab in Details Section 

 
b. The Descriptive tab will show the non-financial information of the asset. 
 

 

Figure 154: Descriptive Tab in Details Section 

 
c. The Source Lines tab will show the source of the asset. 
 

 

Figure 155: Source Lines Tab in Details Section 

 
d. The Assignments tab will show the unit, Depreciation account and location of the 

asset. 
 

 

Figure 156: Assignment Tab in Details Section 
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e. The Cost History tab able to illustrate the movement between Current Cost and 
Original Cost. 

 

 

Figure 157: Cost History Tab in Details Section 

 

f. The Depreciation tab will show the amount depreciate monthly by period. 
 

 

Figure 158: Depreciation Tab in Details Section 

 
g. The Transaction tab will show the transaction performed to the asset. 

 

 

Figure 159: Transactions Tab in Details Section 

 

 

Figure 160: Accounting Lines Box 
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8 ASSET LEASES 

 

Process for Leases Accounting treatment includes tracking, accounting, and monitoring lease 
activities. You can manage lease activities such as asset creation, monthly installment, 
interest expenses, depreciation and reclassification. 

 

Process Summary 

✓ Prepare Lease Agreement 

✓ Define Payment Schedule 

✓ Prepare Lease Schedule 

✓ Create Asset 

✓ Examine Depreciation Amount 

✓ Monthly Installment, Interest Expenses 

✓ Reclassification of Lease Liability 

 

8.1 Create Asset Lease 

In the Create Asset Lease process, you can manually input all lease-related details directly 
into the Fixed Assets module without requiring an invoice number. 

 

1. Manually prepare Lease Schedule (Excel file) containing range of date, interest 

expense, monthly installation, asset cost and monthly depreciation. 

 

Figure 161: Example of Lease Schedule 

 REMINDER 

As per agreed in the Implementation Session, currently lease accounting practices maintained 
through a manual process. Moving forward, these practices will be upheld while integrating 
into the Oracle Fusion system. This approach will combine Manual Processes with System-
based Automation. 
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2. Login to Oracle system. 

Navigate to Fixed Assets > Assets > Task > Add Assets. 

 

 

Figure 162: Task Sidebar in Assets Work Area 

 

3. Enter information in the fields: 
- Book name = Defaulted to LSE Asset Book 
- Asset Type = Capitalized/Expensed 
- Category = Choose Category under LSE-LEASE 

 
 

 

Figure 163: Asset Categories for Leases 
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- Description = Any description 
- Cost = Total Cost of Lease 
- Unit = Total Units of Lease 
- Expense Account = Auto generate based on Asset Categories Setup 
- Location = Any available location 
 

 

Figure 164: Add Asset Box 

 
4. Enter the information in mandatory fields and optional fields on the basis of 

requirement:  

- In Service Date = First period of Contract Start 

- Tag Number, Serial Number, Manufacturer, Model = Non-monetary information 

- Attachment = Advisable to attach Lease Schedule or Contract 

- Asset Key = Insert ‘OTHER’ 

 

 

Figure 165: Add Asset Page 
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5. Expand the Financial Details and Enter financial details which consist of: 
- Depreciation Method 
- Life in Years 
- Life in Months 
- Prorate Convention 
The Depreciation Method, and Life of Asset will auto populate based on the asset 
category. However, you may change if required. 

 

 

Figure 166: General Tab in Financial Details Section 

 
6. Click on Submit button to proceed and it will auto post. 

 

 

Figure 167: Submit Navigation in Add Asset Page 

 

7. Asset will be moved to the Ready to Post section of Additions Infotile.  

Click on Post All and the asset will be created in your Fixed Assets Register. 

 

 

Figure 168: List of Ready to Post in Assets Work Area 
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8.2 Asset Clearing by Create Manual Journal 

 

Journal entry is generated when creating an asset lease manually: 

 

No Scenario Module Accounting Entry Comments 

1. 
Create 
Lease Asset 

Fixed Assets 
Module 

DR Asset Cost 

CR Asset Clearing 

Manual Asset 
Creation 

Table 6: Create Asset Lease Entry 

 

Since this process does not involve the Payables module, the balance remains in the Asset 
Clearing account. To clear this balance, you can create a manual journal and set off the 
clearing amount with Lease Liability: 

 

No Scenario Module Accounting Entry Comments 

1. 
Asset 
Clearing 

Fixed Assets 
Module 

DR Asset Clearing 

CR Lease Liabilities - Long Term 

Manual Journal 
Creation 

Table 7: Asset Clearing Entry 

 

You may follow below steps to achieve those process: 

1. Click on Assets under Fixed Assets on the home page. 
 

 

Figure 169: Personal Home Page 
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2. Go to task > Create Accounting. 

 

Figure 170: Task Sidebar in Assets Work Area 

 
3. Enter the asset book, fill up the fields below and click on the Submit button to proceed. 

- Book = Assigned book 
- Process Category = Leave it blank 
- End Date = End of Month 
- Account Mode = Select Draft 
- Process Events = Select All 
- Report Style = Select Detail 
 

 

Figure 171: Create Accounting Page 

 

4. Navigate to Fixed Assets > Asset Inquiry. 

 

 

Figure 172: Personal Home Page 
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5. Search Recent Lease Creation. 

 

Figure 173: Asset Inquiry Page 

 

6. Navigate to Detail Section > Transaction Tab 

Select Transaction Type ‘Addition’ > Click View Accounting button 

Take note on Account Combination and Amount. 

 

Figure 174: Accounting Lines Box 

 

7. Go the General Accounting > Journals. 

 

 

Figure 175: General Accounting Homepage 
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8. Go the Task > Create Journals. 

 

 

Figure 176: Journal Work Area 

 

9. Enter all the required information. 

- Enter Journal Batch and Description 
- Choose Accounting Period 
- Enter Journal and Description 
- Enter Accounting Date 
- Choose Journal Category 
- Choose Currency, if you need to create journal with other than reporting currency 

for the ledger 
 

 

Figure 177: Create Journal Page (Journal Batch and Journal Section) 
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10. Then enter fields in the Journal Lines section 
- Account Code Combination = Decided by client 
- Amount of Debit or Credit = Based on Lease Schedule 
- Enter the Line Description = Decided by client 

 

 

Figure 178: Create Journal Page (Journal Lines Section) 

 

11. After completed editing your Journal Entry details, you may click Save button, 
Complete button or Post button. 

Save = It will only save the journal with status incomplete. 
Complete = Complete the journal and ready to be posted. 
Post = Complete and post the journal. 
 

 

Figure 179: Create Journal Page (Save, Complete, Post, Cancel Navigation) 

 

12. After completing the Journal Entry details by clicking the Post button you will get 
confirmation popup and the journal requires approval before it can be posted.  
Then, Click OK button. 

 

 

Figure 180: Message Box (Confirmation of Approval Process) 
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8.3 Run Depreciation to Check on Depreciation Expenses Amount 

 

Process calculates the monthly depreciation for the lease asset based on the details entered 
during asset creation. This step ensures that the system-generated depreciation aligns with 
the Lease Schedule. 

 

1. Click on Assets under Fixed Assets springboard. 
 

 

Figure 181: Personal Home Page 

 

2. Click on Calculate Depreciation under Depreciation infotile. 

 

Figure 182: Depreciation Infotile in Assets Work Area 

 

3. The following pop-up message will appear 
 

 

Figure 183: Asset Depreciation Popup Box 
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4. You can view the Depreciation status. Click on Schedule Processes under Tools 
springboard. 

 

 

Figure 184: Personal Home Page 

 
5. Search Calculate Depreciation. 

 

 

Figure 185: Calculate Depreciation Navigation in Scheduled Processes Page 
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6. To see the depreciation calculated on each Asset, navigate to the Asset Inquiry. 
 

 

Figure 186: Personal Home Page 

 
7. Enter relevant Information and search for the Asset whose depreciation you wish to 

view. 
 

 

Figure 187: Asset Inquiry Page 

 

8. Click on Asset number. 
 

 

Figure 188: Asset Inquiry Page 
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9. Click on the Depreciation Tab to view the Depreciation that system has calculated for 
the period. 

 

 

Figure 189: Depreciation Tab in Asset Inquiry Page 
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8.4 Monthly Installment, Interest Expenses by Create Manual Journal 

For each monthly lease installment, a manual journal entry is required to record the payment 
and allocate the interest expense. The entry typically involves: 

 

No Scenario Module Accounting Entry Comments 

1. 
Monthly 
Installment 

Fixed Assets 
Module 

DR Finance Lease Payable – Current 

DR Interest Expense 

CR Amount Due to Group Company 

Manual Journal 
Creation 

Table 8: Monthly Installment, Interest Expenses Entry 

 

You may follow below steps to achieve those process: 

1. Go the General Accounting > Journals. 

 

 

Figure 190: General Accounting Homepage 
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2. Go the Task > Create Journals. 

 

 

Figure 191: Journal Work Area 

 

3. Enter all the required information. 

- Enter Journal Batch and Description 
- Choose Accounting Period 
- Enter Journal and Description 
- Enter Accounting Date 
- Choose Journal Category 
- Choose Currency, if you need to create journal with other than reporting currency 

for the ledger 
 

 

Figure 192: Create Journal Page (Journal Batch and Journal Section) 
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4. Then enter fields in the Journal Lines section 
- Account Code Combination 
- Amount of Debit or Credit. 
- Enter the Line Description. 

 

 

Figure 193: Create Journal Page (Journal Lines Section) 

 

5. After completed editing your Journal Entry details, you may click Save button, 
Complete button or Post button. 

Save = It will only save the journal with status incomplete. 
Complete = Complete the journal and ready to be posted. 
Post = Complete and post the journal. 
 

 

Figure 194: Create Journal Page (Save, Complete, Post, Cancel Navigation) 

 

6. After completing the Journal Entry details by clicking the Post button you will get 
confirmation popup and the journal requires approval before it can be posted.  
Then, Click OK button. 

 

 

Figure 195: Message Box (Confirmation of Approval Process) 
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8.5 Reclassification of Lease Liability by Create Manual Journal 

 

One-time annual process to adjust the classification of lease liabilities. This involves creating 
a manual journal entry to transfer the portion of the liability due within the next 12 months: 

 

No Scenario Module Accounting Entry Comments 

1. Reclass 
Fixed Assets 
Module 

DR Lease Liabilities - Long Term 

CR Finance Lease Payable - Current 

Manual Journal 
Creation 

Table 9: Reclassification of Lease Liability Entry 

 

You may follow below steps to achieve those process: 

1. Go the General Accounting > Journals. 

 

 

Figure 196: General Accounting Homepage 
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2. Go the Task > Create Journals. 

 

 

Figure 197: Journal Work Area 

 

3. Enter all the required information. 

- Enter Journal Batch and Description 
- Choose Accounting Period 
- Enter Journal and Description 
- Enter Accounting Date 
- Choose Journal Category 
- Choose Currency, if you need to create journal with other than reporting currency 

for the ledger 
 

 

Figure 198: Create Journal Page (Journal Batch and Journal Section) 
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4. Then enter fields in the Journal Lines section 
- Account Code Combination 
- Amount of Debit or Credit. 
- Enter the Line Description. 

 

 

Figure 199: Create Journal Page (Journal Lines Section) 

 

5. After completed editing your Journal Entry details, you may click Save button, 
Complete button or Post button. 

Save = It will only save the journal with status incomplete. 
Complete = Complete the journal and ready to be posted. 
Post = Complete and post the journal. 
 

 

Figure 200: Create Journal Page (Save, Complete, Post, Cancel Navigation) 

 

6. After completing the Journal Entry details by clicking the Post button you will get 
confirmation popup and the journal requires approval before it can be posted.  
Then, Click OK button. 

 

 

Figure 201: Message Box (Confirmation of Approval Process) 
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9 MONTH END CLOSING ACTIVITIES 

9.1 Depreciation 

 

Prerequisites 

✓ Depreciation Calculation is to be done at period end. 
✓ Period is to be closed for Asset module. 

 

Process Summary 

Run the Calculate Depreciation process to calculate depreciation for all assets in a book for a 
period. If depreciation is not calculated successfully for any assets, the log file created by 
Oracle Fusion Assets for the depreciation process request lists these assets and the reason 
that depreciation failed. 

 

When you run depreciation, Assets Module gives you the option to close the current period 
automatically after running depreciation. If all your assets depreciate successfully, Assets 
closes the period and opens the next period. If you do not choose the close period option, the 
period remains open. 

 

Note: Depreciation period once closed cannot be reopened 

 

1. Click on Assets under Fixed Assets springboard. 
 

 

Figure 202: Personal Home Page 

 

2. Click on Calculate Depreciation under Depreciation infotile. 

 

Figure 203: Depreciation Infotile in Assets Work Area 
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3. The following pop-up message will appear 
 

 

Figure 204: Asset Depreciation Popup Box 

 

4. You can view the Depreciation status. Click on Schedule Processes under Tools 
springboard. 

 

 

Figure 205: Personal Home Page 

 
5. Search Calculate Depreciation. 

 

 

Figure 206: Calculate Depreciation Navigation in Scheduled Processes Page 
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6. To see the depreciation calculated on each Asset, navigate to the Asset Inquiry. 
 

 

Figure 207: Personal Home Page 

 
7. Enter relevant Information and search for the Asset whose depreciation you wish to 

view. 
 

 

Figure 208: Asset Inquiry Page 

 

8. Click on Asset number. 
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9. Click on the Depreciation Tab to view the Depreciation that system has calculated for 
the period. 

 

 

Figure 209: Depreciation Tab in Asset Inquiry Page 
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9.2 Create Accounting for Transfer Transaction to General Ledger 

 

Prerequisites 

✓ General Ledger (GL) period is open. 
✓ Depreciation Calculation is to be done. 
✓ Transactions have been completed. 

 

Process Summary 

Run the Create Accounting process after all the transactions have been completed for the 
period. This program will create subledger journal and transfer to GL Module. 

 
1. Click on Assets under Fixed Assets on the home page. 

 

 

Figure 210: Personal Home Page 

 
2. Go to task > Create Accounting. 

 

Figure 211: Task Sidebar in Assets Work Area 

 

 
 

 REMINDER 

As per agreed in the Implementation Session, Create Accounting Program will Auto Process 
by the end of every month. 
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3. Enter the asset book, fill up the fields below and field click on the Submit button. 
 

 

Figure 212: Create Accounting Page 

 

4. Navigate to Tools > Scheduled Processes. 

Ensure Create Accounting for Assets, Status: Succeeded 

 

 

Figure 213: Scheduled Processes Page 

 

5. Click on Create Accounting Execution Report program. 

You may view the report in the Process Details tab. 

 

Figure 214: Create Accounting Execution Report Output 
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9.3 Close Period 

 

Prerequisites 

✓ Ensure all transactions for the period are completed. 

✓ Depreciation has been run and reviewed. 

✓ Create Accounting process has been completed and journals are transferred to the 

General Ledger. 

 

Process Summary 

The Close Period process is performed after all asset transactions for the period are finalized. 
This action locks the period, preventing further changes, and ensures the data is ready for 
financial reporting. 

 

1. Click on Assets under Fixed Assets on the springboard. 
 

 

Figure 215: Personal Home Page 

 
 
 

2. Click on Close Period under Depreciation infotile. 
 

 

Figure 216: Depreciation Infotile in Assets Work Area 
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3. Warning box prompt, make sure all transactions for Fixed Assets complete then click 
Yes button. 

 

 

Figure 217: Close Period Warning Box 

 
 

4. The following pop-up message will appear. 
 

 

Figure 218: Asset Depreciation Popup Box 

 
5. You may check the Month under Depreciation Infotile will change to the next month. 
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10 REPORT SUBMISSION 

10.1 Standard Report 

Oracle Fusion Fixed Assets provides predefined reports that cover the following areas: 

• Transaction Reports 

• Mass Additions Reports 

• Reconciliation Reports 

You can schedule and run reports from the Scheduled Processes work area.  

 

Alternatively, you can access the reports from here: 

1. Click on Reports and Analytics, drilldown the Shared Reports and Analytics. 

 

Figure 219: Reports and Analytics Sidebar in Assets Work Area 

 

2. Click on any Standard Report such as Journal Entry Reserve Ledger and system will 

prompt report action screen box. 

 

 

Figure 220: Report Action Screen Box 

 

3. Click  button to run new schedule process. 
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4. The system will direct to Basic Option page before running the schedule process. 

 

 

Figure 221: Basic Option Page 

  

5. Fill up the required field. 

 

6. Click  button and system will schedule new process for this report. 

 

7. To check report status, you need to navigate to Tools > Scheduled Processes. 

 

 

Figure 222: Schedules Processes Navigator 
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8. System will direct to Scheduled Processes page. 

 

 

Figure 223: Scheduled Processes Page 

 

9. Click  button to refresh the program. 

 

10. Ensure the status is Succeeded. Click on the Report and Details section appear. 

 

 

Figure 224: Scheduled Processes Page (Detail Section) 
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11. Click on Output Name to display the report. 

 

 

Figure 225: Journal Entry Reserve Ledger Report 

 

12. User may click on  button to export report in other format such as XML, ODF, RFT, 

Excel or CSV. 

 

13. Repeat the same steps for other reports 

 

 

Transaction Reports 

Display Name Description 

Asset Additions 
Report 

Lists all the assets added or capitalized during the specified 
periods. 

Sorted by and groups totals for each balancing segment, asset 
type, asset account, cost center, and reserve account. 

  

Additions by Source 
Report 

Lists all the assets added or capitalized during the specified 
periods. 

Shows the details of associated invoice lines. 

Sorts and totals by source, balancing segment, asset type, asset 
account, cost center and asset number. 
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Asset Retirements 
Report 

Lists all the asset retirements performed during the specified 
periods. 

Sorted by and groups totals for each balancing segment, asset 
type, asset account, and cost center. 

  

Asset Transaction 
History Report 

Lists all transactions performed on selected assets. 

Sorted by asset number. 

  

Asset Transfers 
Report 

Lists all asset transfers performed during the specified period. 

Sorted by asset number. 

  

CIP Capitalization 
Report 

Lists all the CIP assets capitalized during the specified periods. 

Sorted by and groups totals for each balancing segment, CIP cost 
account, cost center, and asset cost account. 

  

Cost Adjustment 
Report 

Lists all the asset cost adjustments made during the specified 
periods. 

Sorted by and groups totals for each balancing segment, asset 
type, asset cost account, and cost center. 

  

Cost Adjustments by 
Source Report 

Lists all the asset cost adjustments made during the specified 
periods. 

Shows the details of associated invoice lines. 

Sorts and totals by source, balancing segment, asset type, asset 
account, cost center, and asset number. 

  

Asset Category 
Change Report 

Lists all the assets for which the asset category is changed during 
the specified period. 

Sorted by and groups totals for each balancing segment, asset 
account, and asset number. 

  

Asset Impairment 
Report 

Lists the impact of impairment transactions. 

Displays cost, new net book value, net selling price, value in use, 
and impairment loss amount for all the impaired assets in the given 
book and depreciation period. 

Sorted by asset number. 

  

Table 10: List of Transaction Reports 

 

 

 

 

 

 

 

 



Olivestouch Technologies Sdn Bhd 
                                                                              User Manual 

 Fixed Assets Module 

 

Confidential  Page 119 of 129 

 

Mass Additions Reports 

Display Name Description 

Create Mass 
Additions Report 

Lists all invoice and discount lines processed by the last run of the 
Create Mass Additions process. 

Sorted by and groups totals for each foreign currency, balancing 
segment, asset clearing account, and cost center. 

Generated every time the Create Mass Additions process is run. 

  

Delete Mass 
Additions Report 
  

Lists all the mass addition lines in the Delete queue that are ready 
to be processed by the Delete Mass Additions process.  

Post Mass Additions 
Report 

Lists all the asset additions and cost adjustments processed by the 
Post Mass Additions process. 

Sorted by transaction type. 

Generated every time the Post Mass Additions process is run. 

  

Table 11: List of Mass Additions Reports 

Reconciliation Reports 

Display Name Description 

Cost Clearing 
Reconciliation 
Report 

Lists all asset additions and cost adjustments performed during the 
specified period for which accounting entries are created for cost 
clearing accounts. 

Sorted by and groups totals for each transaction type, balancing 
segment, and clearing account. 

  

Cost Detail Report Lists asset level asset cost account balances for the specified 
periods. 

Sorted by and groups totals for each balancing segment, asset cost 
account, and cost center. 

  

Cost Summary 
Report 

Lists asset cost account summary balances for the specified 
periods. 

Sorted by and groups totals for each balancing segment and asset 
cost account. 

  

Journal Entry 
Reserve Ledger 

Lists asset depreciation amounts for the specified period. 

Sorted by and groups totals for each balancing segment, expense 
account, reserve account, and cost center. 

  

CIP Detail Report Lists asset level CIP cost account balances for the specified 
periods. 

Sorted by and groups totals for each balancing segment, CIP cost 
account, and cost center. 

  

CIP Summary 
Report 

Lists CIP cost account summary balances for the specified periods. 

Sorted by and groups totals for each balancing segment and CIP 
cost account. 
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Reserve Detail 
Report 

Lists asset level asset reserve account balances for the specified 
periods. 

Sorted by and groups totals for each balancing segment, reserve 
account, and cost center. 

  

Reserve Summary 
Report 

Lists reserve account summary balances for the specified periods. 

Sorted by and groups totals for each balancing segment and 
reserve account. 

  

Revaluation Reserve 
Detail Report 

Lists asset revaluation reserve account balances for a specified 
period for an asset level. 

Sorted by and groups totals for each balancing segment, asset cost 
account, and cost center. 

  

Revaluation Reserve 
Summary Report 

Lists asset level revaluation reserve account balances for the 
specified periods. 

Sorted by and groups totals for each balancing segment, reserve 
account, and cost center. 

  

Asset Balances 
Register Report 

Lists initial costs, current reserve, year-to-date amounts, 
depreciation rules, and retirements for a range of assets for the 
specified corporate book and for each associated tax book. 

Sorts the data by asset number. 

  

Asset Register 
Report 

Lists the cost-related details, current activity, and retirements for 
every asset within the selected asset category. 

Lists all transactions that impact asset cost during the chosen 
period. 

  

Asset Leases 
Expense Report 

Lists asset lease interest and expense amounts for the specified 
period. 

Sorted by and groups totals for each balancing segment, expense 
account, and cost center. 

  

Asset Leases 
Liability Report 

Lists asset lease liability for the specified period. 

Sorts by and groups totals for each balancing segment, liability 
account, and cost center. 

  

Asset Cost and 
Reserve Report 

Lists the asset cost and depreciation reserve balances at the asset 
or cost center level. 

Sorts and totals by category, asset type, asset cost account, and 
cost center. 

You can run the report only for closed periods. 

  

Table 12: List of Reconciliation Report 
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11 FIXED ASSETS MAINTENANCE SETUP 

 

The maintenance setup can be performed by using Setup and Maintenance. In this Chapter, 
we will be discussing on setup and maintenance for asset category, asset location and asset 
key. 

 

Figure 226: Setting and Actions 

 

Setup and maintenance work area can be accessed from Settings and Actions. It can also be 
accessed by using Others from navigator. 

 

 

Figure 227: Setup and Maintenance Navigator  

 

  



Olivestouch Technologies Sdn Bhd 
                                                                              User Manual 

 Fixed Assets Module 

 

Confidential  Page 122 of 129 

 

11.1 Maintain Asset Categories 

Step 1: You need to check the value set for Fixed Assets Category 

No. Page Name Navigation 

1.  Manage Asset 
Category 

Settings And Actions > Setup and Maintenance > Fixed Assets 
> Manage Fixed Assets Flexfield Value Sets 

Table 13: Manage Fixed Assets Flexfield Value Sets Navigation 

 

1. Choose Module: Assets // Application // FA 

 

 

Figure 228: Manage Fixed Assets Flexfield Value Sets 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Olivestouch Technologies Sdn Bhd 
                                                                              User Manual 

 Fixed Assets Module 

 

Confidential  Page 123 of 129 

 

2. Click either XXRC_FA_CAT_MAJOR or XXRC_FA_CAT_MINOR. 

Then click Manage Values button. 

 

 

Figure 229: Manage Value 

 

3. Click Search button to view all the values. If your desired value is not included in the 

list, you can click  button to add. 

 

4. Then, enter the Value and Description. 

 

5. Click on Save and Close button 

 

Step 2: Uses this page to setup and maintain asset category combinations 

No. Page Name Navigation 

1.  Manage Asset 
Categories  

Settings And Actions > Setup and Maintenance > Fixed Assets 
> Manage Asset Categories 

Table 14: Manage Asset Category Navigation 

 

1. Navigate to setup and maintenance work area. 

2. In Fixed Assets functional area, search Manage Asset Categories Tasks. 

3. System will direct to Manage Asset Categories Activities page 
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Figure 230: Setup and Maintenance 

 

4. The navigation will go to the below screen: 

 

Figure 231: Manage Asset Category 

 

If you don’t have any indicator and wants to see all the categories setup, you can just click 
Search button (1) OR if you have any field to search in specific keywords, you can enter in 
any field on (2) then click Search button (1). 

If you already have the major and minor category set up, but not yet defined in your asset’s 
book. Below are the steps that you should follow: 
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Scenario 1: Add new asset book to the existing asset categories 

Assign Book to the new category Setup: 

 

Figure 232: Edit Category | Accounts Tab 

 

Click Add button (1) then, choose the book (2). Fill in the mandatory information in tab (3).  

You are advised to tick “Default depreciation expense combination” to enable auto populate 
set of account that already define in the mandatory field during creating new asset. This 
account will be populated after you already assign the major and minor asset category. 

 

Then, click on Default Rules (4). 

 

Figure 233: Edit Category | Default Rules 

 

Fill in the depreciation method and useful life. The useful life and month, by default it will be 
appeared during creation new asset, but you still can amend if the asset depreciation years 
different from the default one. Then, choose the appropriate Convention for the asset, this will 
determine on the depreciation calculation soon. 
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If the category is not in the list, you can click Add button to proceed with new categories 
creation.  

 

Scenario 2: New Category Setup 

 

Figure 234: Create Category 

 

Enter Details: 

Mandatory = Major Category, Minor Category, Group Category, Category Type, Ownership 

Optional   = Description, Property Type, Property Class, Capitalized, Enabled, In physical 
inventory, Intangible 

 

Then follow the step in Scenario 1. 
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11.2 Maintain Asset Locations 

 

Step 1: You need to check the value set for Fixed Assets Locations. 

No. Page Name Navigation 

1.  Manage Asset 
Locations 

Settings And Actions > Setup and Maintenance > Fixed Assets 
> Manage Fixed Assets Flexfield Value Sets 

Table 15: Manage Fixed Assets Flexfield Value Sets Navigation 

 

1. Choose Module: Assets // Application // FA 

 

 

Figure 235: Manage Fixed Assets Flexfield Value Sets 

 

2. Click either: 

- XXRC_FA_LOC_STATE = Location Value for Department Owner 
- XXRC_FA_LOC_BRANCH = Location Value for Department 
- XXRC_FA_LOC_CUSTODIAN = Location Value for Branch or Zone 

 

3. Then click Manage Values button. 

 

 



Olivestouch Technologies Sdn Bhd 
                                                                              User Manual 

 Fixed Assets Module 

 

Confidential  Page 128 of 129 

 

 

Figure 236: Manage Values 

 

4. Click Search button to view all the values. If your desired value is not included in the 

list, you can click (+) button to add. 

 

Step 2: Set up combinations for Asset Locations Value. 

Uses this page to setup and maintain asset location combination. 

No. Page Name Navigation 

1.  Manage Asset 
Locations 

Settings And Actions > Setup and Maintenance > Fixed Assets 
> Manage Asset Locations 

Table 16: Manage Asset Locations Navigation 

 

1. Click Search button to view all the values. 

 

Figure 237: Manage Asset Locations 

  

2. Click  button to add new location combinations. Optional to put the effective start 

date. DON’T for get to enable the new listed location.  

 

3. You also can delete the listing that you are not used anymore, by clicking  button 

after selecting the row.  
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